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This is an initial introduction to the fundamental concepts and tools that you need to efficiently use MicroStation 
CONNECT Edition and related applications such as OpenBuildings Designer or OpenRoads Designer. Changes made in 
MicroStation 2023 have been incorporated. 

• Keystroke sequences are indicated by the > symbol, e.g. Esc then 4 will be shown as Esc > 4. 
• Keystroke combinations will be shown by the + symbol, e.g. Ctrl + O (capital letters are used for clarity, either 

case will take effect). They are generally highlighted in bold text. 
• For help use the Help menu. Press F1 for help at any time, the help document will normally open at a page 

relevant to the active command. 

Searching the Bentley Communities wikis and forums for more information is highly recommended, for example the 
MicroStation wiki. 
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Opening MicroStation and Choosing Your WorkSet 

It is always best to open MicroStation from a shortcut rather than by double clicking a file. This is because there are 
many settings that are WorkSet specific such as paths to reference files, default output locations and WorkSet specific 
libraries. It is important that the correct WorkSet is selected before working on your designs. 

Note for V8i users: a V8i Project is now a WorkSet, WorkSets are contained in WorkSpaces. 

On opening MicroStation you are brought to the Work page where you can select your WorkSpace, WorkSet and open 
or create a file. From Update 17 onwards you may also be able to select different configurations, connections to 
configurations are made using the Manage Configuration utility: 

 

The Work Page shows recently used WorkSets on the left, recent files in the active WorkSet and their properties in the 
centre and the WorkSet properties on the right. See the CONNECT Edition help page tilted ‘Using Work page’ for more 
information on the features available here. 

Creation of Configurations, WorkSpaces and WorkSets is normally manged by a CAD system administrator. We have 
wizards that can be used to create WorkSpaces and WorkSets. Please see the help topics ‘Create WorkSpace Dialog’ 
and ‘Create WorkSet Dialog’ for more information. 

Click Browse to (or Ctrl + O) to open a file, note the File and Directory (aka Folder) history drop down menus. A well 
configured system will offer a DGN folder for the selected WorkSet: 

 

Once MicroStation is open click the ribbon File tab to go to the Backstage where you can open other files. Selecting 
the Close item will return to the Work Page. 
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Ctrl + N will open the new File dialog. 

The Welcome Page present prior to Update 13 has been replaced by the Help tab and Title Bar pop-down menus: 
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File Formats 

MicroStation’s file format is DGN.  

The DGN file format has not changed since 2000 so older files can simply be opened and used. Note that while the file 
format itself is unchanged some file content, for instance some content created by OpenBuildings Designer’s tools, 
will need to be upgraded to synchronize with newer application schema and datasets. 

DGN files can be 2D or 3D. This simplifies life when working on 2D only information, there is no Z dimension. 

Note that 3d Files can be referenced into 2D files when composing drawings. This is used by Dynamic views and also 
allows 3D views to be presented alongside conventional 2D views. 

MicroStation can open, edit or create .DWG files using Autodesk RealDWG libraries. A DWG created in MicroStation is 
the same as one created by an Autodesk application. The Autodesk RealDWG libraries have been built into 
MicroStation since the early 2000’s. Bentley maintain compatibility with DWG versions every time Autodesk change 
the format, update 16 adds DWG 2022 to the compatible versions. 

MicroStation can import/export or reference a range of other vector formats including 3DS, SketchUp, and Rhino as 
well as a wide range of other file formats. 

File Open: 
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Mouse Buttons 

Please remember this MicroStation terminology, it is used extensively in the help documents as well as these notes: 

• Left Mouse button  = Data 
• Right Mouse button  = Reset 
• Wheel button/wheel  = Various view controls and combinations with function keys 
• Left + Right Mouse buttons  = Tentative (now rarely used, AccuSnap supersedes it.) 

(Older versions of MicroStation used the Middle Button as Tentative to snap with. AccuSnap does virtually all your Tentative 
snapping work for you so don’t change your Button Assignments. Tentative is available via simultaneous Left + Right Mouse button 
press. Do not remap Tentative to the Middle Button as this will affect the default view control. 
If snap points do not appear try holding down Ctrl + Shift while moving the cursor over potential snap points; in a small number of 
circumstances AccuSnap is supressed.) 

• Middle button pans by dragging; hold it down and drag 

(In these notes Key + middle button indicates clicking or holding down the mouse wheel. Key + mouse wheel indicates rolling the 
mouse wheel) 

• Zoom in and out using mouse wheel 
• Shift + Right-click to show pop-up View controls 
• Alt + mouse wheel to Pan Left/Right 
• Shift + mouse wheel by default is the Pan with Zoom action, you may find changing this combination to Pan 

Up/Down is more useful. From MicroStation’s Workspace menu pick Preferences > Mouse Wheel > Shift + 
Wheel = Pan Up/Down:
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In 3D Only 

Rotate view around a point. This has the following steps: 

Alt + middle button produces a fine white cross, drag this around with the mouse until it snaps to a suitable point 
around which to rotate the model. While being dragged the cross will thicken, it will snap to points with AccuSnap. 
Once snapped the cross will revert to fine thickness and mouse cursor will revert to the navigation icon. Then hold 
down Data and drag the view around.  

Try this out, it’s easier done than described. 

 

Shift + Data to pan around the active plane (i.e. in 2D) with a direction indicator. 
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Getting Started 

Using every MicroStation tool involves a basic sequence: 

Pick the tool, adjust the settings, follow the prompts and Draw... 

Pick your Tool 

Pick your tool by using the Ribbon, pop-up menus/keystrokes or F-keys. See sections below for more on these 
methods. For many tools their use is fairly self-evident once you have established efficient ways of accessing them and 
become used to the basic sequence. 

Adjust the Settings 

Adjust the Settings in the Tool Settings dialog (see below). 

Prompts in the Status Bar 

The Status Bar at the bottom left of the MicroStation application window tells you what command or tool you are 
currently using and prompts for the next input from you. Always look out for this and refer to it when using unfamiliar 
tools or when in doubt what to do next. This is a lot quicker than guessing! 
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Focus 

Focus is where input from the keyboard will take effect. Unlike most applications, MicroStation has several points 
where keyboard input can be applied, you need to be sure you are at the right point before entering your input 
keystrokes. It is important to be familiar with the focus scheme: 

Icon Name Keystroke What it does 

 

Home F12 With the focus at Home you can use the Keyboard 
Shortcuts and, if enabled, Position Mapping keys. 

 

AccuDraw F11 This gives access to all the familiar AccuDraw shortcuts 
and a series of new ones. 

 

Tool 
Settings 

F10 Pressing F10 takes you to the Tool Settings dialog. Once 
there you can use the up/down arrow or Tab keys to 
move up and down the available options, Spacebar to 
display pop-up option menus followed by up/down arrow 
to select from the pop-up menu. 

 

Key-in F9 or Enter Opens the Key-in dialog at the cursor, moving the mouse 
away from the Key-in window closes it. 

 

Home Esc From MicroStation 2023 we enable Esc to exit 
commands by default in DWG workmode.  

• In CONNECT Edition when focus is on other dialogs the icon for that dialog will generally be displayed in the 
Status Bar, in this case the Cell library dialog has focus:

 
Closing a dialog will return focus to Home. 

• Generally pressing the appropriate key will move between focus inputs, if they do not, press Esc followed by 
the appropriate focus key.  

• If in doubt about where your focus lies, press Esc to get to Home, then the appropriate key to move away 
from Home. 

• If you frequently use DWG files in may be better to set to ‘ESC exits command’ On in Preferences for a 
consistent experience across all formats: 
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Tool Pop-ups 

Spacebar 

The Spacebar activates the Popups dialog; it will appear at the mouse cursor offering quick access to a wide range of 
tools. From MicroStation 2023 we also offer the Recents tab, this lists up to 10 recently used tools from the active 
session, use the tab key to switch between the two. 

 

 

The Popups tab contains: 

• Top row: frequently used Ribbon Group shortcuts from the Home tab 
• Middle row: the most frequently used tools 
• Bottom row: other frequently used Ribbon Groups 

This popup content can be customised (described in Help topic “Customizing the Ribbon Group Pop-ups”). 

The number of recent tools saved can be set from 5-10 in preferences > Input > Max Recent Icons. 
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Q or [ 

These keys open popup menus with different 
selector characters suited to left or right hands: 

e.g.: [ followed by P will start the Move tool. 
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The Ribbon 

CONNECT Edition applications use a Ribbon interface. This adheres closely to Microsoft standards for Ribbon 
interfaces providing a feel that will be familiar from other applications such as Microsoft Office. The basic techniques 
for using the Ribbon are similar to those in Microsoft Office and other Ribbon based user interfaces. 

Like most Ribbon based applications there are many shortcuts that enable access to tools by key-in, these are listed 
below, some may be useful. Using F4 to search the Ribbon is the quickest way to find a tool. 

Here are a few tips that apply to all MicroStation based products: 

Changing Ribbon Workflow 

MicroStation includes a number of different Ribbon layouts that we call Workflows. To change Workflow either pick 
the Workflow name from the pop-down menu: 

 

Or more easily, press a key to pop this menu up at the cursor, then press the number of the Workflow that you want: 

 

The key to open this menu varies by region/keyboard, some examples are listed below. 

Region Keystroke 
UK (QWERTY) # 
US (QWERTY) \ 
France (AZERT) * 
Germany (QWERTZ) # 
Denmark (QWERTY) ' 

e.g.: in the UK # > 2 will switch to the Modeling tab (in a 3D file). 
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F4 – Quickly Find a Tool 

Press F4 to search for tools in the Ribbon, Backstage, and Quick Access Toolbar: 

 

• Results will appear as you type 
• Click on the tool name to start it 
• Hovering over a result will display the locations of the tool, there are often several; click on the path to go to 

that location and start the tool 
• Most Recently Used items can be deleted by clicking the red x 

 

Select the Show/Hide Details option to see additional information about the listed tools. 
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Add to Quick Access Toolbar (QAT) 

The Quick Access Toolbar (QAT), like Microsoft Office, provides an easy way for individuals to have their most used 
tools immediately to hand; just click the down arrow at the right-hand end, then pick Customize Quick Access Toolbar: 

 

Show/Hide Ribbon Tools 

 

Right-clicking on a Ribbon Group displays a pop-up menu listing all the tools where they can be ticked on/off. Any 
changes made are stored in each user's preferences. 
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Ribbon Preferences 

The Ribbon preferences offer controls for the size and display of Ribbon items, the default Ribbon Size, Medium, 
displays 24 x 24 pixel icons for the smaller buttons. 

 

Show Popup KeyTip Hints controls whether KeyTips are initially shown for Ribbon Group Popups. This may be useful to 
gain initial familiarity, but as pressing Alt when the popups are open shows the KeyTips, this can generally be left 
unchecked. 

Additional Information 

Look in the top-level topic "The Ribbon" in CONNECT Edition help documents. 
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Other Ribbon Shortcuts 

F2 

Displays the KeyTips for Ribbon Tabs and Quick Access Toolbar (QAT) 

 

Press the appropriate letter to activate the desired Ribbon Tab or number (combination) to activate a QAT tool. 

ALT + <Letter> 

These combinations can be used as an alternative to F2 to open tabs or go to the backstage. For example, Alt+F can be 
used to open the Backstage and Alt+H can be used to switch to the Home tab. These shortcuts are shown in the 
tooltips for all ribbon tabs, this display when the cursor hovers over a tab. 

 

F3 

Displays the KeyTips for the open Ribbon Groups: 

 

Press the appropriate letter combination to activate the desired tool. 

Clearing the KeyTips 

The KeyTips will clear once a tool is selected, to clear without selecting a tool press Esc or right-click to Reset. 
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Tool Settings 

The Tool Settings dialog floats or can be docked. Docking it is not a good idea as this generates a huge blank grey area! 
The name of the Tool Settings dialog will echo the currently active tool: 

 

 
 

The size and content will vary significantly depending on the options available for the active tool. 

• If the Tool Settings dialog is not visible press F10 to bring it back. 
• Use the PopSet (see below) shortcut Ctrl + Spacebar to bring it to your mouse cursor. 

The Tool Settings are crucial; virtually every tool has additional settings that allow you to get the result that you want. 

Some are very obvious; Place Circle for example, gives 
you options for the placement method: Center; Edge; 
Diameter, amongst other things. 

 

 

Create Region is typical of a tool where several 
previously separate tools have been consolidated into 
one that contains all the available options. 
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Element Dimensioning is another example. Here a range of dimensioning methods have been consolidated into one 
tool. Element Dimensioning is also a smart tool that will present different options according to the element being 
dimensioned. 

Linear dimensioning:

 

Radial dimensioning:

 

The tool settings switch between these automatically going to radial when you dimension an arc, circle or ellipse. 

Always look for the little black arrows on the Tool Settings (and other dialogs), these pop-out additional options as 
shown above.  

The collapsed Element Dimensioning Tool Settings dialog looks like this: 
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Explorer Dialog 

The Explorer dialog has been significantly enhanced in CONNECT Edition, the full details are beyond the scope of this 
QuickStart, more information can be found in the help documentation. 

This dialog exposes additional information about files, 
their contents and project resources. 

Where files contain multiple Models, expanding the 
Models list offers a quick way to change Model, double-
click the required Model to open it: 

 

There are many right-click menus that enable direct 
access or actions relevant to the selected item: 
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PopSet 

PopSet has been added to the Ribbon Primary tools in MicroStation 2023: 

 

Settings to control PopSet’s behaviour are found in File > Settings >User > PopSet Settings: 

 

By default, they are set as shown here, the timings and hide border can be changed to suit your own preferences if 
desired. The Hide Border is the zone around the dialog that is sensitive to the mouse. When the mouse enters this 
zone slowly the Tool Settings will be hidden. For more modern higher resolution monitors change the Hide Border 
to a higher value say 30-45. 

Leave the Auto-Position Tool Settings box 
unticked for best behaviour by PopSet. 
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PopSet in Update 17 or earlier 

Prior to MicroStation 2023 
PopSet has to be opened as a 
toolbox, press Ctrl + T to open 
the Toolboxes dialog, then 
scroll down to PopSet, tick the 
box and click OK. Dock the 
PopSet toolbox in a convenient 
place, maybe above the Status 
Bar. 

 

 

PopSet will automatically hide 
the Tool Settings dialog if you 
need to draw in the part of the 
screen it is occupying. Right-
click on the PopSet icon to see 
the PopSet options.  

 

To dock PopSet, place the cursor over the left hand edge of the title bar, press 
and hold the left button to drag, or right-click and pick Move from the pop-up 
menu: 
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Element Selection 

Quick Selection methods: 

• Drag with the Data button (Left button) from Left to Right to select elements within the shaded marquee. 
• Drag with the Data button (Left button) from Right to Left to select elements overlapping the shaded 

marquee, note the marquee will be dotted in this case. 

Both of these methods will be affected by the mode selected in Element Selection Tool Settings, see below. 

Right-press on the drawing background for a pop-up menu including: Select All, Select None (very useful!) or Select 
Previous. Select Previous will recall the previous selection, very useful if a selection is accidentally lost. 

The Element Selection Tool Settings have two rows: 

• The top row is the Method, how you select. 
• The bottom row is the Mode, what you select. 

Using appropriate combinations of these options can really 
speed things up. For example: 

If you want to select everything in an area apart from one or two elements, set the mode to New or Add, Drag + Data 
over the elements. Then set Method to individual and Mode to Subtract and pick those one or two elements to 
remove them from the selection. 

Or 

Select the one or two elements then change the Mode to Invert and then Drag + Data across the whole area. 

Element Handles 

The display of handles can be toggled on/off by the button at top right. They can be used to directly manipulate 
elements, hold down Ctrl to select multiple handles for manipulation. 

Alternate Text Handles 

Blocks of text display two handle types, the “normal” blue square handles and the “alternate” green circle handles.  

• Select a green circle handle to modify the line length of the text element and dynamically change the word 
wrap of the paragraph. 

• Select a blue square handle to alter the size of the text block proportionally, however this results in non-
standard text sizes so is best avoided. 

• AccuDraw can be used in conjunction with handles to maintain alignments of text blocks. 
• Having selected a block of text you can use the Alt key to toggle between the “normal” and “alternate” 

handles, although this has the limitation already described  
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Snapping 

The snaps menu is accessed 
by left-clicking (Data button) 
on the snaps icon in the 
status bar. 

Data button on a snap mode 
to set it for the next action. It 
will then revert to its previous 
setting. 

Data button on the Default 
Snaps pop-up to select the 
required default snap from 
the list. 

Shift + Data to set a snap 
mode to be active for 
multiple actions. 

Shift + Tentative (left + right 
buttons) to pop-up the Snaps 
tool panel at the cursor. 

 

 

Multi-snaps: 

Data button on the Multi-
snaps icon (highlighted 
above) to open the multi 
snaps settings window. 

You can tick any of the snap 
modes listed. They will apply 
in order of priority as listed. 
Each snap mode can be 
moved up or down the list to 
suit your preferences. 
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AccuSnap 

AccuSnap is an essential tool that brings a range of snap functions to your cursor automatically. 

AccuSnap is turned on and off from this dialog. Settings menu > 
Snaps > AccuSnap. 

Working with AccuSnap off is usually a huge waste of time, 
don’t do it!  

The default settings work quite well but can be tweaked to suit 
your preferences. 

Enable for Fence Create allows AccuSnap to work with Fences. 

Hold down Shift + Ctrl to turn AccuSnap off temporarily if you 
want to manually snap to something. Also use to enable for 
Fence Create if you have not ticked Enable for Fence Create 

 

The Elements tab offers options for what AccuSnap identifies. 
In complex files you may wish to turn some of these off. 

Sort hits by element class prioritises Primary elements over 
Constructions, then Patterns and Dimensions so should be left 
on. 

Here are some examples of AccuSnap in action locating 
keypoints. 

The icon next to the yellow cross shows the current snap 
mode. If you are using a multi-snap this icon will vary as the 
available snap points are located. 
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Right-clicking 

Right-click is set by default to Reset (aka Cancel, reject, stop) Reset is used throughout this document. 

On the drawing background  

Reset and hold:  

Brings up this Pop-up tools menu at 
the cursor 

 

On the drawing background  

Shift + Reset: 

Brings up a View Control menu at the 
cursor 
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Isolate/QuickSet 

QuickSet uses MicroStation’s Graphic Group functionality to enable selections of elements to be isolated. To use 
select the elements that you want to see, right-press and pick Displayset Set. All elements outside the selection will be 
hidden. To revert right-press and pick Displayset Clear. 

Alternatively, right-click on element in the Explorer dialog and pick Isolate. To revert right-click and pick Isolate Clear. 

Right-press pop-up menu Right-click in Properties menu 
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Properties (or Element Information) 

The Properties dialog is a powerful tool not only for 
establishing the current state of elements but also for 
making changes. It has the great advantage when making 
changes of enabling you to be sure of the current state 
before changes are applied.  

You can open it either from the Primary Toolbox or by 
pressing Ctrl + I. 

A quick modification sequence is to select one or more 
elements then press Crtl + I, as shown alongside: 

When you select multiple elements, they will be listed at 
the top of the dialog. 

The selection will be highlighted, in the various sections 
below some attributes will be shown as “Varies”. This is 
very useful for identifying inconsistencies.  

Clicking on an individual element in the list will show all 
the attributes for that element. 

Any attribute that is shown in black can be modified 
either by over-typing or by picking from a pop-down list. 
If over-typing does not work use the pop-down, this 
operation of this dialog is not totally consistent yet.  

Where this comes in really useful is for modification of 
several or many elements. 

In this example, in the Contents panel the Text String 
property can be modified, changing all of the selected 
elements. 
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Another example: 

• Place some text elements at varying angles then select them all. 
• Press Ctrl + I 
• Note that in the Geometry section the angle “Varies”. 

 
• Double-click to select **Varies**, type 30 then Enter.  
• All the selected text items will be rotated to 30 degrees. 

Now draw three random diameter circles try modifying their attributes. 

Note: for circles to remain circular both primary and secondary axes must be the same, there is no attribute for radius. 

If too much information is displayed you can right-click on a field to Hide it or, right-click on the grey background of 
the dialog and turn things on and off from the pop-up menus. To see the grey background, either expand the dialog or 
collapse some of the sections. On the basis that you never know when things will come in handy, I leave these alone 
most of the time. 

Changing Element Attributes 

The Change Attributes tool is packed with functions, the eyedropper is particularly useful, but a quick tip to change 
the primary active attributes is hold down the Alt key then click on an element. This will set the active attributes to 
match that element. 
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AccuDraw  

In most instances AccuDraw replaces the need to use several manipulation commands. It does require perseverance 
to become familiar with the shortcuts and exact syntax of some operations. 

AccuDraw adds two features to the interface:  

• A graphic indicator called the "compass" at any active data point on a drawing. 

   
• A precision input window, the AccuDraw window, with fields for entry of x,y (and z in 3d drawings) 

coordinates or polar (distance,angle) coordinates as appropriate. 

  

The active field will be determined by the cursor direction/location relative to the compass. For example, move the 
cursor in the x direction, the x field will become active automatically, just type in the dimension and click the left 
mouse button.  

Keyboard short cuts offer single key operation when the focus is in the AccuDraw window (focus = highlighted field or 
button). With AccuDraw in focus press ‘?’ to see a list of AccuDraw shortcuts, see below for more on these. 

AccuDraw Settings 

Generally, the default settings work well but if you wish to 
explore further, press F4 and start to type ‘AccuDraw Settings’, 
then open the dialog: 

One setting that you may wish to change is: 
‘Show Negative Angles’ 
This is on by default so angles must be input with positive or 
negative values relative to the active axis: 

 

Turning this off results in angles being displayed from 0-360° 
which may be more intuitive in some situations: 
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Starting AccuDraw  

AccuDraw is set to be on by default in user preferences. 

If it has been turned off click the AccuDraw button in a Ribbon Primary Group (F4 to search the Ribbon). 

 

Controlling the Compass 

The Compass operates in two modes, rectangular and polar. In rectangular mode x and y dimensions are input. In 
polar mode angle and distance are input. 

Switching from one mode to the other is achieved by pressing ‘M’. 

The compass will rotate as elements are drawn so that the angles are always relative to the last element. This 
becomes apparent when elements are placed at non-orthogonal angles. 

The compass can be rotated back to x,y orientation to the view by pressing V, i.e. y vertical, x horizontal to the right. 

Basic Drawing with the Compass  

Try drawing a line with AccuDraw on (if focus is not in the AccuDraw dialog, press F11).  At the start of the line the 
compass appears. Notice that when the cursor is within about 3° of the x or y axes the line will snap to the axis. 

When the line is snapped to an axis, press Return. The line will then be locked to that axis, its length can be set either 
by keying in a dimension or by snapping to another element, note that the line remains on axis wherever the element 
being snapped to is located. 

Pressing X or Y will lock the current value entered into the AccuDraw window X or Y fields. This value can either be 
typed in or obtained by snapping to an element. 

AccuDraw remembers the last dimension you used, draw a line, then another and watch for the grey bar that appears 
when you get to the previous length: 
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AccuDraw's Shortcuts 

These are some of the most useful standard Shortcuts: 

Enter Smart Lock 

Press Enter key to lock elements onto the AccuDraw axes. For example, once Enter is pressed a line will remain locked 
on the selected axis regardless of the mouse position. 

M Change Mode  

Press M to switch from X Y Z rectangular coordinates to polar (angle and distance) coordinates. 

View Rotation 

V View Rotation 

Press V to rotate the AccuDraw compass back from an angle to orthogonal x,y orientation aligned with the view. Use V 
when the view has been rotated. 

T, F and S Rotation 

In 3D rotate the compass to Top, Front and Side planes with these keys. In 2D T will rotate to the true XY. Note that if 
the 2D view is rotated this will be different to the View orientation. 

E Cycle Rotation 

In 3D press E repeatedly to cycle through the rotations. 

O Set origin 

Press O to set the start point (origin) for a command relative to a snap point or data point.  

To use this, snap to a point, then press O, you will then be able to input dimensions using AccuDraw to move the 
origin (or start point) of the next step in the operation which you are performing. 

This function can replace many operations where an element is initially located by snapping to an existing element 
and then moved by distance to a new position. It will be equally useful in many other situations. The following simple 
example will explain: 

The sequence is: 

• Start AccuDraw. 
• Select the tool which you wish to use, Place Block for example. 
• Snap to the first point. 
• Then before you do anything else, press O (the letter not the number, note that it isn’t case sensitive) 
• Now move the cursor, see that the dimensions in the AccuDraw window are following the cursor and 

that when the cursor moves near to an axis a white guideline appears. What you are moving is the start 
point for the block.  
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For example, to place a block 300 x 300 away from the first snap point enter 300 into both AccuDraw window fields 
and accept with the data button. The first point of the block will now be 300 x 300 away from the start point.  

This can be used in sequences, in the example above the start point of the block is placed relative to a point, the 
opposite corner of the block could be placed relative to another point with a similar sequence. It takes a little getting 
used to but once you have become familiar with the sequence offset can save a lot of copying around of elements and 
eliminates the need for most construction lines.  

Snaps  

AccuDraw has several shortcuts to temporarily override the current Snap Mode. 

• Intersect snap, press I. 
• Centre snap, press C. 
• Keypoint snap, press K. This will bring up a small dialogue box where the number of keypoints can be 

changed.  

 
• Nearest snap, press N. 

The override will revert to the current Snap Mode once the current snap action has been accepted.  
For instance: place a line with Keypoint as your current Snap Mode, use AccuDraw I to override to Intersect snap, snap 
to the intersection, accept that snap and the snap will immediately revert to Keypoint. 

Rotating the Compass  

The compass can rotate to align with the normal orthogonal grid but can also be rotated in several ways to other grids 
that relate to buildings or other real-world features. 

Rotating the AccuDraw grid.  

When drawing objects that are not aligned to a normal grid e.g., existing buildings, the compass can be rotated to the 
desired alignment. This can be done either temporarily for a single operation or set for a series of operations. These 
take a little getting used to but once you get the sequence right are very useful. 

RE 

This rotates the compass to align with an existing element. Type RE then hover over and click on the element that you 
wish to align with. 

RA 

RA does two things, it either rotates AccuDraw to the active ACS, if there is one, or allows you to set rotation for a 
series of operations. RE is quicker and easier to use in most cases.  
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Enter a data point at one end of the element whose orientation you wish to match, type RA, when prompted, snap 
again to the same point, then snap to the other end of the existing element and accept with the left button. The 
compass will remain in this orientation until either another RA is executed or any of V, T, F, S and E are used to rotate 
the compass back to normal x,y (,z) orientation. 

RQ 

To set rotation for a single operation enter a data point, type RQ and then snap to another point to define the 
rotation. This rotation will persist until the next time the reset button is pressed.  

B Base Rotation 

Potentially useful in 3D. If you have used RQ or RA this returns to the plane that you are working in. i.e. if you were in 
the F rotation when you used RQ to do a quick rotate in that plane, B will unrotate you back to F, whereas pressing T, 
V or E will take you to another plane. Worth playing with. 

PP/PM 

It can be useful to specify data point by coordinates. MicroStation has a precision input function which in AccuDraw is 
invoked by P, offering the choice of inputting a single point or a series of points: 

 

Press P again to open the Data Point Keyin dialog for one point to be entered. Enter the coordinates in the format x,y,z 
then press Enter. The dialog will close.  

 

Press M to enter multiple points, the dialog will remain open for input of a sequence of coordinates.  

Combining AccuDraw functions  

Any of the AccuDraw shortcut keys can be used in sequence. For example, try O to offset an element position followed 
by I to snap the endpoint of the element to an intersection. 

` Bump Tool Settings 

The first pop-down menu in Tool Settings can be toggled 
through using the accent key (for English and European 
keyboards, other regions can vary). 
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Docking 

Many dialogs can be docked, icons showing the available options will display when a dialog is dragged. 

They include the available positions and tabbed options, drag the cursor over the icon to see a preview of the docked 
location: 

 

Once docked dialogs can be pinned as tabs: 
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Setting your User Preferences: 

From MicroStation’s Workspace menu pick Preferences where a couple of useful options are: 

Help 

Turn off Use Online Help, this will speed up access to the help documents as it uses the local files. 

 

Multiple Monitors 

If you have multiple monitors MicroStation can be set to open a separate window for each monitor (up to four) that 
can be maximised to each avoiding a single window stretched across multiple monitors: 

 

View Options 

View Options: Tick the two boxes shown changing Selection Set Colour to Cyan (or another of your preference), these 
will override whatever colours are set in each design file giving you consistent colours.  
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